
Getting Started on RTTY

Introduction

Everyday more and more Amateur Radio operators are operating on the HF digital modes, in particular, RTTY.  In each RTTY 
contest I operate, I find about 8-10% new calls that I've not seen before.  There are several reasons for wanting to be a RTTY op.   No 
matter what that reason might be, it is the purpose of these pages to assist getting you started on RTTY.

Even though I've been active on RTTY for over 20 years, have won several RTTY contests and have achieved RTTY DXCC Honor 
Roll, I don't claim to have all the answers.  I do have a technical background and am familiar with many of the technical aspects of 
operating RTTY.  RTTY is the most fun I've had in over 30 years of Amateur radio.  It can be both complicated and simple.  So I'll try 
to keep things simple.

Anyone can operate RTTY.  You don't have to know how to touch type to run RTTY.  Hunt & peck works fine.  Every program I 
know for RTTY includes special "buffers" which hold pre-typed messages that can be sent by pressing a function key or clicking a 
button on your screen with a mouse.  The late Junior, previously N5JR (this call has since been re-issued to Joel Rubenstein who is an 
active RTTY operator too), was a paraplegic and earned RTTY DXCC before he died.  He operated RTTY with a stick in his mouth.  
He should be an inspiration to all of us and shows that even those with disabilities can enjoy this very fun and exciting mode.  There's 
really no excuse not to try.

Whether you desire to operate RTTY for DX'ing, contesting or ragchewing, you have to start somewhere.  It's my hope that I can point 
you in the right direction.  From there you will be able to make your own decisions on how you want to operate RTTY from your 
station.

RTTY is Baudot code (see http://en.wikipedia.org/wiki/Baudot_code for excellent information on Mr. Baudot and his code).  More 
specifically, on the Amateur HF bands, it's 5 bit Baudot meaning that every character consists of five bits, either mark or space (in 
actuality Baudot is 8 bits because a start bit and two stop bits are added for synchronization see http://www.aa5au.com/gettingstarted/
rtty_diddles_technical.htm).  In general, a baud rate of 45.45 baud is used on HF.  45.45 baud is the equivalent of 60 wpm.  Even 
though 45.45 is standard, you will occasionally come across a RTTY signal at a different speed.  Ed, P5/4L4FN, preferred to run 50 
baud rate (66 wpm) when he was active on RTTY from North Korea.  75 baud (100 wpm) can also be used on the Amateur HF bands.

The standard mark and space tones are 2125 hz and 2295 hz respectively.  These frequency tones are also referred to as “high” tones.  
Although these standard tones are used by most Amateurs, it's possible to operate RTTY using other frequency tones. This is fine as 
long as you maintain the standard 170 hz shift (2295-2125 = 170 hz).  Some commercial TNC's such as the KAM and PK232 use a 
200 hz shift when running AFSK.   Although 200 hz shift will work OK,  170 hz is standard on HF.  Sound card programs will 
sometimes change the frequency of the mark and space tones when transmitting AFSK while using the NET feature to line up your 
transmit signal with that of a received station, but they maintain the 170 hz shift.  Although that's important to know, I suggest not 
using the NET feature just yet.

For the purpose of getting you started, MMTTY will be used here as the example program to use for running RTTY.  Why?  For 
several reasons.  MMTTY is a simple program to use.  It's easy to set up and in all the years I've operated RTTY, MMTTY is the best 
decoder I've ever used.  The best part of MMTTY is that it's free!  The MMTTY help file has an abundance of information about 
RTTY in general.

AFSK vs. FSK (Audio Frequency Shift Keying vs. Frequency Shift Keying)

The biggest decision you will make when you begin to set up for RTTY, is whether you want to use AFSK or FSK to transmit RTTY.  
Either way is acceptable.

There is an excellent explanation of AFSK and FSK in the MMTTY help file so I won't go into a lot of technical detail here.  For 
simplicity sakes, AFSK and FSK are terms to describe how RTTY is transmitted.  AFSK is when you send audio from a TNC or 
Sound Card to the audio input of your transmitter either via the mic input or accessory jack.  FSK is when you send on/off keying 
from a TNC or Serial COM port (with MMTTY you can also use a parallel LPT port to transmit FSK) to the FSK input of your 
transmitter.  Most modern transceivers today have an FSK input.  By using the FSK input to your transceiver, you can then operate the 
radio in the RTTY or FSK position and make use of filters available for receiving RTTY, such as a narrow 250hz or 500hz IF filter.  
In most cases, when using AFSK, your radio will be placed in the LSB position (although some, especially in Europe, prefer using 
USB).

I am biased in my opinion of AFSK vs. FSK.  I prefer FSK over AFSK all of the time.  There are advantages and disadvantages to 
both.  When operating AFSK, you must make sure the audio coming from your TNC or Sound Card is at the correct level and 
maintain this level.  If the audio is too high it will overdrive your transmitter and more than likely result in a distorted RF signal or 
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cause your radio to put out "image" signals across the band.  You also must make sure you do not have the speech processor turned on 
when transmitting AFSK RTTY.  This will also cause problems on your RF signal.  The only real advantages to running AFSK are 
that you can get started rather quickly using this method because it's simple audio-to-a-soundcard input for receive and audio-from-a-
soundcard output to your transceiver for transmit and you can also make use of the NET features of sound card programs.  But 
personally, I think NET is a nice feature, but it can cause problems when not used correctly.  Another disadvantage of using AFSK is 
that most transceivers will not allow you to use the narrow IF filters in your radio when operating in the LSB or USB positions.  Some 
recently manufactured radios allow you to change the characteristics of your IF filters so you can effectively receive RTTY in the SSB 
position.  Check your manual to see if this is the case for your radio.  And if you wonder how your radio works on RTTY, go back to 
my RTTY Page and find your radio listed under my "RTTY Radios" section.

I prefer FSK because it's straight on/off keying into the FSK input of my radio.  I don't have to worry about the audio level or whether 
I forgot to turn the speech processor off.  I can then use the FSK mode on my radio along with the narrow 250 and 500 hz filters.  
When I switch from SSB to RTTY, I only have to change the mode on my radio.  There is a little more work involved when using 
FSK.  If you use a sound card, you must have a spare serial COM port (or parallel LPT port) available on your PC in order to key both 
FSK and PTT, whereas if you use AFSK, you don't need this extra COM or LPT port and you can use VOX to key the radio.  
However, if you use MMTTY or any other sound card program to generate AFSK and use VOX to key your radio, any other sound 
generated by Windows could possibly key your radio and send that sound out on the air.  That would not be good.  There are ways to 
keep this from happening and I will explain that as well.

There is more detailed information covering AFSK and FSK on pages 5, 6 and 7 which will help you make your decision on whether 
to set up for AFSK or FSK RTTY transmission.

Let's get started.  The first thing we will do is to download MMTTY from the Web.

Installing MMTTY

Here are detailed instructions on how to install MMTTY from the MM HamSoft web site.   As noted below in the instructions, if you 
are running Vista or Windows 7, you will need to install MMTTY in a location other than the default location C:\Program Files
\MMTTY.  At this time, you should create a directory on your hard drive where you want to install MMTTY such as C:\MMTTY.  
Once this folder is created, you may begin the installation.  Windows 98 and Windows XP users can use the default location which 
will be created automatically in the installation process.

1. Go the MMTTY Home Page here.  Scroll down to the Downloads section and locate the link to MMTTY168A.exe Full Version (or 
whatever the latest version that is showing).  Click on this link.

2. When the 'File Download' screen appears, choose 'Run'.

http://www.aa5au.com/rtty.html
http://hamsoft.ca/
file:///C:/MMTTY
http://hamsoft.ca/pages/mmtty.php


3. You should then see the installation program begin downloading to your computer.  Wait until it completes.  If you have the 'Close 
this dialog box when download completes' option selected, this screen is close when the downloads completes.  Otherwise, if you 
don't have this option checked, close this dialog box after the file has been downloaded.

4. When the file download is complete, you will see the screen below.  Choose 'Run'.

5. The 'Verifying...' screen will appear while the installation file is being downloaded to a temporary folder on your hard drive.  After 
the file has downloaded, the Setup window will appear.



6. When the 'Setup - MMTTY' screen appears, close all other applications that may be running on your computer, and click 'Next'.

7. The next two screens (not shown here) are for the License Agreement and an Information screen.  MMTTY is freeware, so agree to 
the terms in the first screen and read the information on the Information screen, then click Next.  In the next screen (shown below) you 
will have the option where to install MMTTY.  Windows 98 and Windows XP users should use the default location C:\Program Files
\MMTTY.  Windows Vista and Windows 7 users must install MMTTY in a different directory such as C:\MMTTY or any directory 
other than C:\Program Files\MMTTY.  In order to install MMTTY in a directory other than C:\Program Files\MMTTY, click the 
Browse button and navigate to the directory where you want to install MMTTY.



8.  All users may use 'MMTTY' as the program's shortcut in the Start Menu Folder.  Click 'Next'.

9.  It's a good idea to create a desktop icon.  A Quick Launch icon can also be created if desired.  Click 'Next'.



10.  Verify the destination location, start menu folder and additional tasks such as creating desktop and/or quick start icons, the click 
'Next'.  If the information shown on this screen is not correct, click the 'Back' button to go back and make changes or corrections.

11.  Read through the Information screen.  There is good information here, although it is not critical to the installation.



12.  When the setup is completed, you have the option to 'Launch MMTTY'.  Click 'Finish'.

13. MMTTY will start and a dialog box will display where you will enter your callsign.  Enter your callsign and click 'OK'.



This completes the installation process.  

Running MMTTY

When you first start MMTTY, the upper left-hand part of the the screen should look like this.  Immediately go to the Help pull-down 
menu and select MMTTY Help.  Browse through the ENTIRE help file.  The help file is excellent.

Once you have browsed the entire help file and hopefully read most of it, you will then be ready for the next step.  The next step will 
be hooking up your sound card to your radio to RECEIVE RTTY.  We will concentrate on receiving RTTY first.  Once you've read 
the help file and can receive RTTY, then you should be ready to make that most important decision - transmitting AFSK or FSK - and 
we will move on to transmit.

Along the way, if you have problems, the best place to ask is the MMTTY User's Group.  This is an MMTTY reflector on Yahoo that 
you can join.  You can access this User's Group by going to the Help pull-down menu within MMTTY and select "MMTTY User's 
Group".  Choosing this option will open up your web browser to where you can join the User's Group.  There are lots of users of 
MMTTY that will be very happy to help you.  I'm not an MMTTY expert.  It worked straight out of the box for me.  I don't use all of 
the functions such as the log or contest features.  But if you have questions, don't hesitate to send them to me at aa5au@bellsouth.net.

I don't use the MMTTY program for my everyday RTTY operation.  I do use MMTTY as part of my WriteLog contest program.  A 
special MMTTY plug-in was written by Jorgen, SM6SRW, for WriteLog.  And I use WriteLog with the MMTTY plug-in nearly 
every day.   If you are a WriteLog user, then by all means, continue with this tutorial and learn MMTTY.  From there, you can easily 
use MMTTY with WriteLog.  I maintain a WriteLog RTTY website at www.rttycontesting.com and have a full set of instructions on 
how to use the MMTTY plug-in for WriteLog there.

Receive Audio

Hooking up the Sound Card to your radio to receive RTTY is pretty easy.  You'll need to buy or make a cable in order to do this.  
Many operators use commercially made interfaces such as a West Mountain Radio RIGblaster, MFJ Sound Card Interface or Bux 
Comm Rascal to connect the sound card to the radio.  These interfaces are covered in more detail on page Page 9.

The basic idea is to come from the audio output of your radio and go to the audio input of your sound card.  You can go directly from 
radio to sound card, but it's always a good idea to put an audio transformer in line between your radio and sound card for isolation.  
Although this is not absolutely necessary, it is good practice.  When we get to the transmit part of RTTY, and if you decide to use 
AFSK transmission, you will also want to put the same type audio transformer between the audio output of the Sound Card and the 
audio input of your radio.  The most popular transformer used for this application is the Radio Shack audio isolation transformer part 
number 273-1374.  Here is a diagram showing the connection.
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Courtesy of W5BBR website www.w5bbr.com

The computer end of the cable is pretty simple.  Your sound card will be either stereo or mono.  More than likely, it will be a stereo 
sound card.  It doesn't matter.  In most cases, the plug required is a 1/8" (3.5mm) phone plug (Radio Shack p/n 274-284).  This is a 
stereo plug with tip, ring and sleeve.  Use the tip pin for your audio and the sleeve for your ground and shield.  You can use the ring if 
you like, but if your Sound Card is mono, it won't work.  Normally, tip is left channel, ring is right channel and sleeve is common or 
ground. You don't have to use a stereo plug.  You could use a mono plug regardless of whether your Sound Card is stereo or mono.  In 
any case, it's best to use shielded cable in an attempt to keep RF off the audio line.  In MMTTY you can use left channel, right channel 
or mono.  This is selected in MMTTY under Options, Setup MMTTY on the Misc tab.

The radio end of the cable requires a little thought.  There are several ways to derive audio from your transceiver.  You could get the 
audio from an accessory jack or come straight from the PHONES plug or from an external audio filter that you may already be using.  
Some discussion is required here.

Getting the audio from an accessory jack usual works well, especially if you can vary the level of that audio with a menu command on 
your radio.  If the audio coming from the accessory jack is at a constant level , you can still adjust the level to the input of the sound 
card through the Windows Recording control in most cases.  Getting the audio from an accessory jack may be advantageous since you 
will be able to adjust the audio gain on the front on your transceiver to a comfortable listening level while maintaining a constant level 
to the Sound Card.  This is important.

I've always used audio coming from the PHONES jack (via an external audio filter).  If you decide to get your audio from the 
PHONES jack, you need to consider how you are going to listen to the RTTY tones coming from your receiver as well.  It's necessary 
to listen to the tones coming from your radio when operating RTTY to assist in identifying and tuning the signal (in the case of deaf 
operators, tuning could be done by using the tuning indicators alone but it's difficult and takes practice).  You could simply split the 
audio coming from your PHONES jack with a Y cable or adapter.  Or better yet, as I do, you could use an external audio filter to 
further filter the signal before sending it to your Sound Card and headphones.  I use a JPS NIR-12 on my radios.  A JPS NIR-10 or 
Timewave DSP-599 will also work.  If you already have some sort of external filter, it's recommended that you take the audio output 
from that filter and send it to your sound card.  In many cases, doing it this way,  will not disrupt the audio going to your headphones.  
There is a big difference in the quality of audio coming from a commercial or home-brew audio filter and the audio coming straight 
out of your PHONES jack.  Cleaning up the audio before sending it the Sound Card will prove wonders when copying RTTY, 
especially weak signals. The nice thing about getting audio from your PHONES jack directly or via an external audio filter is that you 
can vary the level with the audio gain control of the radio to obtain a proper input level to your sound card and still maintain a 
comfortable listening level to your headphones or speaker.

The NIR-12 audio filter allows me have a constant level coming out of the filter and still be able to adjust the volume control on the 
front of the unit for easy listening in my headphones much like using audio from the radio's accessory jack except I have an added 
advantage of adjusting the audio input to the filter with the audio gain control of my transceiver.  The NIR-12 is no longer available 
on the market, but I'm willing to guess most of the other commercial external audio filters have this same feature.

You can also obtain your audio from a SPEAKERS jack, but if you do this, you definitely should have an isolation transformer in line 
to get rid of any hum or voltage that might be present and you may need to attenuate the audio using a resistive "pad".  To start out, it's 
not important where the receive audio comes from as long as you can still listen to the RTTY tones and get the correct level of audio 
to the input of your Sound Card.

The best source I know of for excellent information on interfacing to a Sound Card is on W5BBR's web site at www.w5bbr.com/
soundbd.html.  Go there and study the different ways of interfacing to your Sound Card.  Make the necessary connection between 
your radio's receiver and your PC's Sound Card input then come back here and we'll see if we can print some RTTY.

Receiving RTTY with MMTTY

It is assumed you have a cable connected from an audio output of your radio to the audio input of your PC's Sound Card.  Bring up 
MMTTY on your PC.  Go to the View menu.  Ensure the Control Panel, Macro Buttons, FFT Display and the XY Scope options are 
selected.  It's also advisable to set the FFT Width to 500 Hz to start out.  You can change some of these settings later when you 
become more comfortable with the program.
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Turn on your radio, set it to either LSB or FSK (or RTTY mode) with an antenna connected.  You should see some activity in 
MMTTY's tuning indicators and depending on the squelch setting, you may even see some characters scrolling across the receive 
window and it may look like this.

 

 

If your screen looks like this, you may be off to a good start.  What you are seeing in the tuning displays is noise.  If the noise is high 

enough for the signal indicator (green horizontal bar ) to go above the vertical mark showing the squelch threshold, 
then characters, looking like gibberish, will appear in the receive window.  To set the squelch threshold, click inside the signal 
indicator where you want to move the vertical threshold marker.  Seeing the "alphabet soup", as it is sometimes called, is a good 
thing.  Don't be bothered by these random characters.  Instead, be glad you are seeing them because it means that MMTTY is seeing 
some sort of audio and it's enough to decode these noise characters.

If your signal level or tuning indicators are not active at all, then something is wrong.  It may be something as simple as not having the 
correct sound card channel (left, right or mono) selected within MMTTY (Options, Setup MMTTY) or the audio level not being high 
enough for MMTTY to recognize it. Another thing to try is turning the BPF on or off using the BPF button just above the signal 
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